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Appendix A

What’s New in
Chief Architect X11

Welcome to Chief Architect X11. This guide has been written to help our upgrading 
customers make a smooth transition from earlier versions of Chief Architect to Chief 
Architect X11. 

Contents
•      Getting Started CheckList
•      Considerations for Legacy Files
•      New and Improved Features

Getting Started CheckList
There are many new features in Chief Architect X11, and many existing features have 
changed. The following checklist suggests steps you should take before migrating your files 
to Chief Architect X11. More information about each of these steps can be found after the 
checklist.
1.      Check for and Install Program Updates
2.      Review the New Features List
3.      Migrate Legacy Library Files
4.      Migrate Custom Graphics Files
5.      Review Your Preferences Settings
6.      Create new custom Template Plan and Layout files
7.      Set up Custom Toolbar Configurations
8.      Backup Entire Plan
9.      Check chiefarchitect.com for more information

1. Check for and Install Program Updates
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Program updates contain improvements to the original release version and we recommend 
using the most current version available. By default, Chief Architect checks for program 
updates every day when you launch the program. Please note that program updates are 
available for download, which means that you need internet access to acquire them.
You can check for updates at any time: 
• Select Help> Download Program Updates from the menu. 
• Visit the Program Updates page on the Chief Architect Web site at chiefarchitect.com. 
2. Review the New Features List 
There are a number of important reasons why you should familiarize yourself with the new 
and improved features in Chief Architect X11:
• New and improved features allow you to produce drawings more efficiently, so it is to 

your advantage to use them. 
• Some changes to existing functionality may affect your accustomed drawing style and 

thus your productivity if you are not aware of them. 
• New features may affect your choice of settings in your template files, as well as your 

preferred Preferences settings. 
See “New and Improved Features” on page 10. 
3. Migrate Legacy Library Files 
Library content from previous program versions cannot be installed or copied into the Chief 
Architect X11 library. If you have Chief Architect version X5 through X10 installed on your 
computer, the Migrate Settings dialog will display after you activate the license, allowing 
you to migrate Preference settings, toolbars, library content, and more for use in Chief 
Architect X11. If multiple legacy versions are present on the system, only the data 
associated with the most recent will be migrated. 
You can import library files from versions X1 through X5 at any time by selecting Library> 
Import Library (.calib, .calibz) from the program menu. In addition, library files from 
versions 10 and prior can be imported by selecting Library> Convert Legacy (.alb) Library 
Files from the program menu.
4. Migrate Custom Graphics Files
If you have custom graphics files, including textures, images or backdrops, that you were 
using in a previous program version, you can copy them manually using your operating 
system for use in Chief Architect X11. 
• Copy custom texture files to the Chief Architect X11 Textures folder located in the Chief 

Architect X11 Data folder. 
• Copy custom image files to your Chief Architect X11 Images folder located in the Chief 

Architect X11 Data folder. 
• Copy custom backdrop files to your Chief Architect X11 Backdrops folder located in the 

Chief Architect X11 Data folder. 

http://www.chiefarchitect.com/
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In Chief Architect X10 through X1, custom graphics were saved in the Chief Architect Data 
folder, as they are in version X11. In version 10, they were located in the program’s 
installation directory, in folders that began with “My”. Custom backdrops, for example, 
were saved in “My Backdrops”. 
Texture and image files are not listed in the Library Browser. These files can be assigned to 
material and image objects, however, which are stored in the library so it is important to 
retain them.
5. Review Your Preferences Settings 
Although you can migrate your Preferences settings from Versions X5 through X10 into 
Version X11, the settings that are available in Version X11 may differ from previous program 
versions. You should review all the settings in the Preferences dialog to make sure that they 
are set to suit your drawing needs.
6. Create new custom Template Plan and Layout files 
Chief Architect X11 installs a selection of template plan and layout files that have been set 
up to take advantage of the program’s updated tools and features. Although you can 
migrate your template files for use in Version X11, for best results it is recommended that 
you either: 
• Use the installed templates when creating new plans and layout files in Chief Architect 

X11
• Use the installed templates as the basis for creating new custom templates.
If you choose to continue using custom template files that you created in a previous 
program version, it is very important that you take the time to carefully review all the 
default settings in the file, making sure that they will continue to suit your needs in X11. 
First, make copies of your custom templates in the Chief Architect X11 Templates directory 
The Templates directory is located in the Chief Architect X11 Data folder. Next, open each 
template as you would a regular plan or layout file, by selecting File> Open, and then save 
any changes you make by selecting File> Save.
If you do choose to continue using a legacy template plan, it is best to also use a legacy 
layout template from the same program version, as well. As with a template plan, take the 
time to go through the layout template’s defaults and make sure they are suited for use in 
X11 and that their line weight scales do not conflict with those in your template plans.
7. Set up Custom Toolbar Configurations 
It is possible to migrate toolbar configuration files from previous versions to Chief Architect 
X11; however, it is possible that your migrated toolbars will be missing new tools available 
in Version X11. 
We recommend that you set up your custom toolbars the way you would like them in Chief 
Architect X11. You may find it most effective to customize your toolbars as you get used to 
working in the new program version, rather than beforehand.  
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8. Backup Entire Plan
Before migrating a legacy file created in Chief Architect X10 or prior, it is a good idea to 
open the plan in the program version in which it was created and use the Backup Entire Plan 
tool (Export Entire Plan in version X3 and prior) to export the plan with all associated 
support files, including textures, backdrops and images.  
9. Check chiefarchitect.com for more information 
If you have additional questions about the changes in Chief Architect, up to date 
information is available in the Support section of our web site. You can also post questions 
on the ChiefTalk web forum at chieftalk.chiefarchitect.com.

Considerations for Legacy Files
As in all software, every new program version introduces changes to its functionality as well 
as to the user interface. If you choose to bring a project forward, be sure to take a few 
moments to look it over in the new version and confirm that the new functionality does not 
require you to make any modifications. Particularly if you have an approaching deadline, 
you may find it best to finish the current project in the version of the software in which you 
began it. 
Chief Architect X11 can open the .plan and .layout files from prior versions. Files with the 
older .pl and .la file extensions are no longer supported and cannot be opened by Chief 
Architect X11. Before opening any files created in earlier versions of Chief Architect, it is 
important to be aware of changes made in the newest version and the effect they may have 
on your legacy plan and layout files. 
Please note that files saved in the latest program version cannot be read by older versions 
of the software. When a legacy file is saved in the version X11, an unaltered copy of the 
original file is created in the Chief Architect X11 Data folder, under Archives, which can still 
be opened in the original version.
• “For Files Created in Version X10 and Prior” on page 4
• “For Files Created in Version X8 and Prior” on page 6
• “For Files Created in Version X7 and Prior” on page 6
• “For Files Created in Version X6 and Prior” on page 7
• “For Files Created in Version X5 and Prior” on page 7
• “For Files Created in Version X4 and Prior” on page 7
• “For Files Created in Version X3 and Prior” on page 9
• “For Files Created in Version X2 and Prior” on page 9

For Files Created in Version X10 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X10 or prior, bear in mind the following:

https://chieftalk.chiefarchitect.com/
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1. Marker and Elevation Point Heights
In Chief Architect X10 and prior, the # sign could be added to the label of a Marker or 
Elevation Point and the label would report the height of the Marker or the Elevation Point’s 
elevation. In Version X11, text macros are used to report this information instead. In legacy 
plans, any # signs in Marker or Elevation Point labels will be replaced by the %heightf% or 
%elevationf% macro.
2. Glass Shower Walls
In Chief Architect X10 and prior, the “Glass Shower” wall type was included in installed 
template files and like other wall types, built to the structural layer of floors and ceilings 
and to the Main Layer of adjacent walls. In Version X11, this wall type has the new Partition 
Wall attribute and instead builds to floor, ceiling, and wall surfaces. When a legacy file is 
opened in Version X11, this wall type will be modified to have Partition Wall checked 
automatically and existing walls will be affected by this change.
3. Fixture Schedules
In Chief Architect X10 and prior, 3D Elevations and Perspectives in Fixture Schedules 
showed cabinet fixtures inserted into a cabinet. In Version X11, fixtures are shown on their 
own, even when they are inserted into an object in the plan. When a legacy file is opened in 
Version X11, any fixture schedules showing 3D views of objects may be affected by this 
change.

For Files Created in Version X9 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X9 or prior, bear in mind the following:
1. Parallel Lights
In Chief Architect X9 and prior, Parallel Light sources could be specified for electrical light 
fixtures and Added Lights. In Version X11, Parallel Lights are no longer supported. In legacy 
plans opened in Version X11, any Parallel Light sources will be converted to Spot Lights.
2. Brick Ledges
In Chief Architect X9 and prior, brick ledges were not represented in floor plan view. In 
Version X11, brick ledges are drawn in plan view on the “Slabs” layer in stem wall and grade 
beam foundations, and on the “Walls, Foundation” layer in monolithic slab foundations. 
When a legacy file is opened in Version X11, brick ledges, if present, will be drawn.
3. Window Types
In Chief Architect X9 and prior, the %type% text macro for windows reported some Window 
Types using abbreviations. In Version X11, the abbreviations were replaced with full words. 
When a legacy file is opened in Version X11, the width of Window Schedules may be 
affected, as may the width of columns in saved Materials Lists.
4. Joist Direction Lines
In Chief Architect X9 and prior, Joist Direction Lines described all platform framing as 
“joists” and used nominal lumber sizes in whole inches in US Unit plans. In Version X11, the 
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platform’s framing Structure Type is reported and in US Unit plans, the size is described in 
fractional inches. When a legacy file is opened in Version X11, Joist Direction Lines will use 
the new, more accurate labeling.
5. Custom Schedule Columns
In Chief Architect X9 and prior, custom schedule columns could be created by adding a Sub 
Category to a type of object on the Categories panel of the Preferences dialog. In Version 
X11, Sub Categories can no longer be created in this manner. When a legacy file is opened in 
Version X11, any Sub Categories shown as custom schedule columns will be converted to 
Custom Fields.
6. Registered User Text Macros
In Chief Architect X9 and prior, a selection of Registered User Text Macros could be inserted 
into Texts, Callouts, and Markers. These macros no longer displayed any data and in Version 
X11, they are no longer recognized. When a legacy file is opened in Version X11, any 
Registered User macros inserted into text objects are treated as regular text.

For Files Created in Version X8 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X8 or prior, bear in mind the following: 
1. Layer Names
In Chief Architect X8 and prior, turning off the Modify Name in all Layer Sets option made it 
possible to assign different names to the same layer in different layer sets. In Version X9,this 
option was no longer supported. When a legacy file is opened in X11, the layer names used 
in the currently active layer set will be retained and any other layer names in other layer 
sets will be discarded.

For Files Created in Version X7 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X7 or prior, bear in mind the following:
1. Boxed Eaves
In Chief Architect X8, improvements to the generation of Boxed Eaves ensure that they 
extend into exterior rooms with “Use Soffit Surface for Ceiling” specified when located 
between the roof baseline and an interior room. In some legacy plans opened in Version 
X11, the Length value for Boxed Eaves may need to be modified in the Roof Plane 
Specification dialog.
2. Uppercase Text
The Uppercase option was added to Text Styles in Version X8, whereas in Version X7 and 
prior, it was an option for Room Labels and Schedules only. In legacy plans opened in 
Version X8, any Schedules present in the drawing will be assigned a Custom Text Style, as 
will their associated Schedule Defaults. If any Schedule Default is set to Use Layer for Text 
Style and no objects are present on that layer, a new Schedule Text Style will be created and 
assigned to that layer. Room Labels are treated similarly: if any are present, they and their 
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defaults will use a Custom Text Style. If a given Room Label or Schedule has been sent to 
layout more than once and was set to use different Text Styles in each layout view, it is 
possible that its appearance may be affected in some views.

For Files Created in Version X6 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X6 or prior, bear in mind the following:
1. Built-in Appliances
In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base 
cabinets had incorrect sizing data. In legacy plans opened in Version X11, these appliances 
will not fit into the cabinet correctly and will need to be replaced. Built-in dishwashers are 
particularly affected.
2. Formatting of Bulleted and Numbered Lists
In Version X7, various improvements were made to the way lines of Rich Text are spaced. In 
legacy plans opened in Version X7, Rich Text objects with bulleted and numbered lists may 
require adjustments.
3. Chief Blueprint Font
The Chief Blueprint font was improved for Version X6, with decreased top and bottom 
spacing. The change in spacing may increase the overall height of text objects using this font 
in X6 files opened in Version X11. X5 and prior legacy files will not be affected by this 
change.

For Files Created in Version X5 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X5 or prior, bear in mind the following:
1. Name-Value Pairs for Doors and Windows
In Version X6, the NVPs door_style_name, door_type_name, and window_type_name 
were shortened to style_name and type_name. Any object labels or text macros using 
these NVPs in legacy plans opened in Version X11 will need to be replaced.

For Files Created in Version X4 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X4 or prior, bear in mind the following:
1. Roof Overhangs and Framing
In Chief Architect X4 and prior, roof overhangs were measured to the outside of the 
subfascia, whereas in Version X5 and later, they are measured to the outside of the fascia or 
shadow boards, if present. In legacy plans opened in Version X11, this will not affect the 
appearance of roof planes in floor plan view because in X4 and prior, roof plane polylines 
represented the projected framing area whereas in Version X11 they represent the total 
projected area. But, the position of the fascia and subfascia will shift, as will the length of 
the rafters.
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2. Door Swing Direction and Materials
In Chief Architect X4 and prior, exterior doors that swing outward display interior material 
on exterior side of door. This was corrected in Version X11. Doors modified to work around 
the old behavior could be affected in legacy plans opened in Version X5.
3. Door Swing Direction and Louvers
Improvements to door louver direction may affect louvers in all doors with the exception of 
bifold doors.
4. Wrapped Door/Window Lintels and Window Sills
In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those 
that were not wrapped. In legacy plans opened in Version X11, the extents of wrapped 
lintels and sills will be adjusted so that they equal their Extend setting.
5. Cabinet Feet
The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork 
symbol to insert into cabinets effectively. In Version X11, the offset is set in the Cabinet 
Specification dialogs. When legacy plans are opened in Version X5, cabinet foot offsets are 
set to 0 and transferred to their containing cabinet, if one exists. Any customized or 
independently placed cabinet feet will be affected.
6. Object Labels in Cross Section/Elevation Views
If a “Label” layer is turned on in a cross section/elevation view and objects of that type are 
visible in the view, then those objects’ labels will display in that view when the plan is 
opened in Version X11.
7. Transparent Materials
In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing 
were visible in rendered views even when their Index of Refraction was set to 1.0. When 
legacy plans are opened in Version X11, Transparent materials with an Index of Refraction 
of 1.0 are transferred to the General Material class and assigned a Transparency value of 
100%. This will not affect these materials’ appearance in ray trace views, but will make 
them completely invisible in rendered views.
8. Registered User Text Macros
In Chief Architect X4 and prior, a selection of Registered User Text Macros could be inserted 
into Texts, Callouts, and Markers. These macros reported information that was provided 
when the program was installed and registered on the computer. In Version X5 and later, 
the program no longer collects registered user information. When a legacy file is opened in 
Version X11, any Registered User macros inserted into text objects are treated as regular 
text.
9. Invisible Beams
The legacy Invisible Beam check box was removed from the Wall Specification dialog. 
When legacy plans are opened in Version X11, any Invisible Beam walls will be converted to 
Invisible Walls. 



Considerations for Legacy Files

 9

For Files Created in Version X3 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X3 or prior, bear in mind the following:
1. Text Styles
The appearance of a number of objects that include text - including object labels, the North 
Pointer, Sun Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can 
now be controlled using Text Style. Their appearance may be altered somewhat in legacy 
plans opened in Chief Architect X11.
2. Light Sources
The illumination created by light fixtures and Added Lights was improved in Chief Architect 
X11. Lighting in legacy plans may appear noticeably brighter when viewed in version X11.

For Files Created in Version X2 and Prior
If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the 
following file management changes and structural enhancements:
1. Legacy file formats
Chief Architect 9.5 and prior files were saved in  .pl and .la the file formats. These file 
formats files are no longer supported and cannot be opened in version X11. 
2. Material textures, images, and backdrops
Chief Architect X2 and prior installed with a catalog of library content, including a selection 
of material textures, images, and backdrops. This library catalog is no longer installed with 
the program because it is now available for download on-demand, so it will be possible to 
open a legacy plan in version X11 and encounter numerous missing file warnings. To avoid 
this, we recommend using the Export Entire Plan feature in the original program version to 
create a folder that includes the plan and all associated textures, images, and backdrops 
before opening this file in X11. This tool is renamed Backup Entire Plan in version X11.
3. Floor and ceiling finish thicknesses
In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and 
objects such as railings, stairs, landings, cabinets, fixtures, and furnishings measured their 
Floor to Bottom height from the subfloor. These objects now measure their Floor to Bottom 
height from the floor finish surface by default, so it is possible that you may notice height 
changes for these objects - particularly in saved, annotated cross section/elevation views.
4. Riser heights and landing thicknesses
The default Best Fit Riser Height for stairs that do not reach the next level has been updated 
from 9” (225 mm) in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X11.
5. Auto Adjust Height
The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust 
Height check box. If a cabinet, fireplace, fixture, furniture, or other library symbol had 
Follow Terrain unchecked in version X2 or prior and was located in a room with a floor 
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height other than the default for the current floor, then the object’s Floor to Bottom Height 
will change to equal that room’s floor height. The object’s position in the model will not 
change, however. 
6. Adjustable Thickness Walls
In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When 
a legacy plan file is opened in version X11 and these wall types are detected, they are 
replaced by an updated, non-generic wall type. Framed walls and Railings will also acquire 
1/2” (13 mm) thick layers of sheetrock on each side.
7. Stairwells defined by railings
Interior railings that used a generic, single-layer wall type drawn in older program versions 
will acquire layers of sheetrock when the plan is opened in version X11. This can affect the 
appearance of staircases where they join to a floor platform. To address this issue, select 
the railing and move it 1/2” (13 mm) away from the top edge of the staircase. 
8. Deck rooms
In legacy plans opened in Chief Architect X11, Deck rooms with Advanced Deck Framing 
built retain the framing but have Automatic Deck Framing turned off by default. Decks with 
no Advanced Deck Framing built are converted to Balcony rooms.
9. Material definitions and light sources
Settings in the Define Material dialog that affect materials’ appearance of brightness have 
been modified. The Ambient setting was removed, and the Diffuse setting for materials in 
legacy plans will be set to 100% when opened in version X11. 
The Quality setting for light sources set to use Soft Shadows in ray tracing was also 
modified. Lights using Soft Shadows in legacy plans will be set to use Medium quality. The 
Light Diameter of light sources in legacy plans is capped at 4” (100 mm).
10. Structural Member Reporting
When a plan created in Chief Architect X2 or prior is opened in Chief Architect X11, 
Materials Lists are set to calculate Total Lineal Length. For a combination of lineal length 
and piece count, select Mixed Reporting in the Structural Member Reporting dialog.
11. Fill New Framing Members
In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief 
Architect X11 it applies to the entire plan. As a result, it is turned off by default in legacy 
plans opened in version X11.

New and Improved Features
The following is a list of new and improved features in Chief Architect Version X11.

Installation
• Backup installer media is now offered on reusable USB drive instead of DVD. 
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• New option in the Mac installer launches Finder to Applications so the program can be 
launched. 

Program Overview
• Items in the File> Import and File> Export menus are now grouped together with divider 

lines between the groups. 
• Improved appearance of the resize grips for dialog and side window panes. 
• In the Mac version, Command + . can now be used to close dialogs. 

File Management
• New Copy Externally Referenced Material Files to My Data Folder option in the 

Preferences dialog. 
• New Associate Files With This Program option in the Preferences dialog. 

Project Management
• The Reference Display can now show objects in other plan files.

Preferences and Default Settings
• New Color Themes settings in the Preferences dialog allow you to customize the colors 

used in the Chief Architect program interface. 
• Dynamic default text fields are now identified by an Active Defaults  icon instead of a 

(D). 
• The location of the User Library Folder can now be specified in the Preferences dialog. 
• The Master List File pathname now updates to stay in the Data folder when the My Data 

Folder location is changed. 
• Existing Layer Sets are now always used when importing Annotation Sets.
• Graphical buttons in the Annotation Sets and Active Defaults dialogs now have tool tips.

• Materials can now be imported using the Import Default Settings  tool.
• New Custom Colors for the text and header row in the Materials List. 

Toolbars and Hotkeys

• New View> Crosshairs  toggle in the menus. 

• Ctrl + F is now the default hotkey for Find/Replace Text . 

View and Window Tools
• Saved plan views can now be imported from one plan to another.

Displaying Objects
• New Tool Tips and icons in the Layer Display Options dialog report where layers marked 

as Used are in use. 
• New Tool Tip for Color bars in dialogs through the program reports the RGB value of the 

selected color. 



12

Chief Architect X11

• New Replace and Copy options for existing layer sets in the Import Layer Sets dialog.
• Deprecated Replace Identically Named Layers check box removed from the Import Layer 

Sets dialog.

Editing Objects

• New Marquee Select Similar  edit tool group lets you marquee-select objects of the 
same type(s), including rooms. 

• The Shift and Ctrl keys now work differently when group-selecting objects. 

• New Simplify Polyline  removes very small polyline edges. 

• The Disconnect Edges  tool no longer breaks electrical connections or sprinkler lines. 

• The Apply Properties  edit tool now supports marquee selection.

CAD Objects

• New Fill Style Painter Tools . 
• Fill Styles can now be saved in the library. 
• The horizontal and vertical offsets for fill styles can now be specified. 

• New Import Pattern  tool. 
• New Attach Tail and Attach Head to Other Objects options for CAD arrows. 
• New information regarding segment line count and holes added to the POLYLINE panel of 

various specification dialogs. 
• New Line Style Management dialog lets you control which line styles are saved in the cur-

rent plan or layout file.
• Obsolete Create Line Style tool was removed from the program.
• New Tool Tips and icons in the CAD Block Management dialog report where CAD blocks 

marked as Used are in use.
• Improved performance when blocking a large amount of CAD objects into a CAD block.
• Improved performance creating CAD blocks with large numbers of objects.

Walls, Railings, and Fencing

• New Make Wall(s) Invisible  and Make Wall(s) Visible  edit buttons. 

• New Straight Glass Wall  and Straight Glass Pony Wall  tools. 
• Pony Walls now have a full defaults dialog similar to other wall defaults. 
• The OBJECT INFORMATION panel was added to the Wall Specification dialog. 

• New Wall Schedule  tool.
• New Partition Wall option in the Wall Type Definitions dialog prevents walls from cutting 

through surface layers of floors, ceilings, and other walls.
• New Split Pony Wall option for wall caps in the Wall Specification dialog.
• New No Room Moldings option in the Wall Specification dialog.
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• New No Room Wall Coverings option in the Wall Specification dialog. 
• Wall insulation is now only calculated for exterior walls with one or more Framing layers. 
• The Upper Wall Outline and Lower Wall setting now works correctly with Railing Pony 

Walls.
• The Default button on the RAILS panel now restores the rail profiles set in the defaults dia-

log associated with the selected railing or fencing object.
• The default rail profiles for railings as well as stairs and ramps now have a preview in their 

objects’ specification dialogs.

Rooms
• Redesigned and enhanced cross section diagram in the Room Specification dialog. 

Dimensions
• The Auto Interior Dimensions tool was removed in favor of the edit tool of the same 

name. 
• Improved Auto Interior Dimensions generate fewer identical dimension lines. 
• Auto Refresh Dimensions is now an option for all Auto Dimensions except Auto Interior 

and Auto Story Pole Dimensions.
• Dimensions drawn in elevation views can now locate the Top of Pony Wall.
• The initial size and other attributes of Point Markers created in conjunction with dimen-

sion lines, are now drawn from the currently active Saved Marker Defaults. 
• The LOCATE OBJECTS panel of the Dimension Defaults dialogs now has category level check 

boxes. 

Text, Callouts, and Markers
• New Note , Note Schedule , and Note Type Management  tools let you efficiently create 

and edit plan notes.

• New Find and Replace Text  tool.

• Notes  Callouts  and Markers  now have the Add to Library  edit tool.
• Common shortcut keys to toggle Bold, Italic, and Underline text modifiers now work in 

the Rich Text Specification dialog. 
• The Height value in the Marker Specification dialog now reflects the height of the marker 

in cross section/elevation views. 
• Common fraction characters have been added to the Chief Blueprint font. 
• Lines with Arrows now display the Selected Edge Handle Fill color in an end edit handle 

when that end is attached to an object. 
• The Insert Macro  button icon is now used in all dialogs where macro insertion is an 

option.
• The deprecated # sign in Marker labels was replaced by new text macros: %height% 

which reports a value in inches (mm) and %heightf% which uses formatting set in the 
General CAD Defaults dialog.
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Doors and Windows

• New Fixed Door , Barn Door , and Shower Door  tools. 
• New Custom door panel settings for sliding, pocket, and bifold doors. 
• New edit handle for sliding, pocket, and bifold doors lets you control the Percent Open. 
• Jambs are now editable for walls in railing pony walls. 
• Hinge side for doors can now be transferred using the Match Properties tool.
• New Type setting for door symbols in the Symbol Specification dialog.

Cabinets
• New Custom Backsplash Defaults dialog.
• The Width setting is now at the top of the Cabinet Specification dialogs. 

Electrical
• New Rope Light  tool.

• Auto Place Outlets  now works in rooms where no door is present. 

• Improved drawing and snapping of Connect Electrical  splines. 
• Electrical symbols can now be assigned a fill color.
• Improved how electrical objects mount on Pony Walls. 

Schedules and Object Labels
• In the Fixture Specification dialog, 3D Elevations and Perspectives no longer show the 

containing cabinet of an inserted fixture.
• New Use Plan View Scale option for schedules that have a 2D Symbol column.
• Improved line weights used by 2D Symbols in various specification dialogs.
• The Schedule Specification dialog now has Margin settings.
• Improved line weights used by 2D Symbols in various specification dialogs.
• New %simple_schedule_number% Name-Value Pair for objects associated with schedules 

that omits the schedule label prefix.

• Improved how column width is applied when the Set as Default  tool is used with 
schedules.

Foundations
• The default hotkey for Build Foundation was changed to Ctrl + 0 in Windows, Command + 

0 in macOS. 
• The deprecated Fireplace tool has been removed from the Build menu. 
• A progress dialog now displays instead of an Information message when a complex foun-

dation is rebuilding. 
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Multiple Floors
• The defaults for all floor levels are now listed in the Default Settings dialog, and can be 

group-selected for editing. 
• Multiple Reference Floors can now display at the same time, each with its own layer set, 

using an editable drawing order.
• Improved automatic Reference Floor Display behavior. 
• The Layer Display Options dialog for the Reference Floor is now accessible via the 

Change Floor/Reference, Saved Plan View Specification, and Layout Box Specification 
dialogs. 

• The obsolete Reference Floor Display Options tool has been removed from the program 
toolbars and menu. 

• The deprecated Swap Floor/Reference tool was removed from the program toolbars and 
menu.

Stairs, Ramps, and Landings
• Stair landings now recognize one another and adjust their heights to form stair-like paths. 
• Enhanced ability to control generation of railings on each landing edge.
• Improved ability to create fully housed stringers using a wall. 
• Improved how flooring materials are mapped on landings. 

Roofs
• The gutter material can now be specified for individual roof planes in the Roof Plane 

Specification dialog. 
• Ridge Caps, Gutters, and Shadow Boards can now be generated or suppressed for each 

roof plane edge.
• New GUTTERS panel in the Build Roof and Roof Plane Specification dialogs.
• Obsolete Gutters check box was removed from the Build Roof and Roof Plane 

Specification dialogs.

Framing

• New Find Wall  edit tool locates the wall associated with a selected framing member in 
a Wall Detail or 3D view in which wall framing can be seen.

Trusses
• New Lock Truss Envelope and Webbing check box in the Truss Specification dialog 

replaces the Lock Truss Envelope option. 

• New Find Trusses  edit tool locates and selects trusses in plan view associated with a 
truss in the Truss Detail.

Trim and Moldings
• The MOLDINGS panel found in various dialogs has been redesigned for greater ease of use. 
• Moldings assigned to an object can be grouped into a stack.
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• New Add to Library as Stacked Molding  edit tool creates a stacked molding profile 
composed of multiple components.

• The width of Ridge Caps and other 3D Molding Polylines now displays in plan view.

The Library
• Parametric cabinets, doors, and windows can now be edited in the library. 
• Newly imported library catalogs are now selected in the Library Browser tree list.

• Enhanced Add to Library As  dialog lets you select and add multiple object components 
as well as materials.

Custom Symbols

• New Select Stretch Plane Item , Show Stretch Planes , and Show Bounding Box  
preview display options in the Symbol Specification dialog.

• New Convert Selected to Symbol  edit tool for architectural objects.
• Improved performance of the Auto Generate option for CAD blocks representing symbol 

objects.

Other Objects
• Improved functionality of Sloped Soffit, Place Under Ceiling, and Place Under Roof 

options for Soffits. 
• Light sources associated with fixtures assigned to Distribution Paths and Regions now cast 

light.
• Improved how objects in Distribution Paths and Regions are included in schedules and 

materials lists for individual rooms.
• Redesigned Material Layers Definition dialogs for floor and ceiling platforms, Custom 

Backsplashes, and more. 

Materials
• Material patterns are no longer tied to materials list calculations. 
• New Keep Pattern/Texture in Sync check box in the Define Material dialog. 
• New Pattern from Texture tool lets you create a custom material pattern based on the 

material’s texture.
• Global Symbol Mapping now affects patterns as well as textures. 
• New MATERIALS LIST panel added to the Define Material dialog. 
• Obsolete General panel removed from the Define Material dialog. 
• The 3D shape preview for materials was added to the Plan Materials dialog. 
• Multiple items in the Material Defaults dialog can now be selected and edited as a group. 
• Deprecated DXF Code, Joint Width, and Mortar Width settings were removed from the 

Define Material dialog. 
• Obsolete Overlap Amount and Grouping settings were removed from the Define Material 

dialog. 
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• Custom material textures are now copied into the Chief Architect X11 Data folder. 

3D Views
• The deprecated Perspective Floor Camera tool has been removed from the menus and 

default toolbars. 
• In the Mac version, the temporary hotkey for Mouse Orbit Camera is now the left mouse 

button with the Command + Shift keys. 

• Expanded options for navigating in Virtual Reality .

3D Rendering and Ray Tracing

• Ray traces can now be Paused .
• Ray traces view tabs now report the associated camera’s name.
• Light sources associated with fixtures assigned to Distribution Paths and Regions now cast 

light.
• The plan view Display Size of Added Lights can now be specified. 
• A Sun Angle can now be specified as the default sun used in newly created cameras. 

Pictures, Images, and Walkthroughs
• New Walkthrough Defaults dialog. 
• The screen resolution used to record walkthroughs can now be specified. 
• Walkthroughs can now be recorded as .mp4 and .wmv files. 
• The codec used for recording walkthroughs can now be set in the Walkthrough Options 

dialog instead of in Preferences. 

• New Export PDF  tool. 
• Improved how imported PDF boxes update if the associated .pdf file is modified. 
• Transparent pixels associated with Image objects are now ignored when selecting objects. 

Importing and Exporting
• Chief Architect 3D Viewer models can now be replaced during export. 
• Notes can now be created in Chief Architect, seen in camera views, and included in 

exported 3D Viewer models.
• Added support for Sketchup version 2019 file import. 

Terrain
• The Auto Rebuild Terrain check box is now located in the Terrain Specification dialog 

instead of the 3D View Defaults dialog. 

• Text macros can now be inserted  into the text of Elevation Points.
• The deprecated # sign in Elevation Point labels was replaced by new text macros: %eleva-

tion% which reports a value in inches (mm) and %elevationf% which uses formatting set 
in the General CAD Defaults dialog.
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Materials List
• The Components edit tool has been replaced by the new COMPONENTS panel in various 

object specification dialogs. 
• Components data is no longer removed when an object is edited. 

• New Calculate Materials From Selection  edit tool creates a materials list for the 
selected objects only. 

• The Materials List can now be printed and exported in color. 
• The Unit column in the Materials List was retired in favor of incorporating units into the 

Count and Extra columns. 
• The Materials List now reports the correct dimensions of lintels, sills, and window aprons. 
• The Materials List now correctly reports doorways located in and electrical objects placed 

on railing walls.
• Pony Walls in the Thermal Envelope are now correctly calculated.
• The deprecated DXF Code setting for materials was removed.

Layout

• New Create Saved Plan View  and Unlink Saved Plan View  edit tools for layout 
boxes.

• Plot Line elevation views with shadows now always have a white as their background 
color. 

Printing and Plotting
• The deprecated Print Model tool has been removed from the software.

Ruby in Chief Architect
• Expanded Name-Value Pairs can report information about related objects and Custom 

Object Fields, allowing greater flexibility when creating Materials List Line Item macros.
• New Name-Value Pairs for most object types.
• New %object_properties% macro reports all NVPs, NVPublishers, and Collections associ-

ated with an object.
• Area and volume values reported by default Object Specific macros are now rounded. 

Custom User Defined macros are not unless they include rounding code.
• New height, elevation, and position Name-Value Pairs for Markers and Elevation Points.
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